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Hoofdstuk 1: Introductie 
 
 

In dit hoofdstuk wordt beschreven hoe je: 

 Deze handleiding gebruikt 

 Vector aanzet en instelt 

 De gebruikersinterface (dat deel van Vector wat nodig is om met de 
computer te communiceren) benut 
 De beeldschermen indeelt 

 De trackball kunt gebruiken als muis bij een computer 

 Het verticale wiel gebruikt als een scrollwiel 

 De verschillende kleuren op het beeldscherm interpreteert 

 De beeldschermen instelt 

 De Workspace gebruikt 

 De soft keys instelt 
 
 
  
 

Afspraken in deze tekst 
 

 Toetsenbord TOETSEN zijn VET met HOOFDLETTERS. 

 Scherm KNOPPEN zijn VET met HOOFDLETTERS en CURSIEF. 

 Invulschermen, menu’s, submenu’s, en veldnamen zijn in dit 
lettertype. 

 De opdrachtregel, onderaan het scherm,  toont de ingevoerde 
commando’s en foutmeldingen. 

 Meldingen en tekst in de opdrachtregel zijn cursief. 

 # is een ingevoerd getal. 

 PBD betekent playback device. 

 SK betekent Soft Keys. 

 Systeem, tafel en bedieningspaneel worden afwisselend gebruikt. 
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 Toetsen of knoppen tussen haakjes ( ) zijn optioneel. Voorbeeld: 
SPOT # (#) ACTIVE. 

 Opeenvolgende toetsaanslagen worden gescheiden door komma’s. 
Voorbeeld: SPOT, #, ,#, ACTIVE 

 Een + teken staat voor ‘tegelijkertijd’: Toets DIT en DAT 
tegelijkertijd. Voorbeeld: SHIFT + FREE. Komt vaak voor in 
combinatie met ‘shift’. 

 Klik staat zowel voor drukken op een muisknop als aanraken van de 
knoppen op het touch screen. 

 Een cel is het kleinste deel dat informatie bevat, zoals één parameter 
van een geautomatiseerde schijnwerper. 

 
 
 

Vector instellen 
 

1 Zet het bedieningspaneel op een schoon, stabiel en vlak oppervlak. 
 

2 Zorg ervoor dat de voltage-keuzeschakelaar, die zich bij de 
stroomtoevoer bevindt, correct is ingesteld voor 230V AC of 110V 
AC. 

 
3 Sluit Vector aan op het elektriciteitsnet met behulp van de 

bijgeleverde kabel.  
 

4 Sluit alle randapparatuur aan op de connectoren aan de achterzijde 
van Vector. Alle connectoren hebben een naam en standaard 
icoontjes. 

 
5 Zet Vector aan met behulp van de schakelaar op aan de achterzijde. 

De ‘soft’schakelaar aan de voorzijde brandt. 
 

6 Druk eenmaal op de ‘soft’schakelaar aan de voorzijde van Vector. 
Wacht tot Vector compleet opgestart is. 

 
7 Sluit de DMX kabels aan op de juiste poorten. 

 
 

BELANGRIJK! Het is verstandig een UPS (back up stroomvoorziening) 
(minimum 600VA) te gebruiken om je werk en de tafel te beschermen. 
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Vector Uitzetten 
 

1 Druk in de Aan/Uit knop. Die zit aan de voorkant v/d console. 
2 Klik op Turn-Off , de Vector wordt uitgeschakeld . 

 
 
 

Vector Methodes 
 
Vector kent twee methodes (mode): 

 Tracking  
 Compulite  

 
Vector biedt twee syntaxis ( zinsbouw) aan: 

 Action ( dit is ook de Syntaxis van Compulite oude lichttafels) 
 Enter  

De werk methode en de syntaxis worden geïnstalleerd  in de Tools >System 
Setting>Behavior tabblad . 
 
Tracking methode (Track= Spoor) 
In de Tracking werkwijze worden alleen de veranderingen (moves) tussen twee op een 
volgende lichtstanden (cues) op geslagen. 
Parameters waarden die in de lichtstand zijn opgeslagen (moves) worden ‘Harde 
Values’ genoemd. 
Parameters waarden die onveranderd zijn t.o.v. de vorige lichtstand (en ook niet in de 
lichtstand zijn opgeslagen), worden ‘Tracking Values ’ genoemd. 
Na het opslaan van de lichtstand, wordt de Editor opgeruimd (gereset). 
Soms wilt men de Tracking (het doorslepen van parameters waarden) stoppen. Dat 
kan bv. voorkomen worden als een nieuwe scene wordt geprogrammeerd. In dit geval 
wordt er  gebruik gemaakt van een ‘Block Cue’, deze lichtstand reset de tracking. 
Compulite methode 
Compulite werkwijze is, dat wat in de belichting jargon het ‘Cue Only Mode’ wordt 
genoemd. D.w.z. dat alleen de parameters die in de Editor zijn, worden in de 
lichtstand op geslagen. 
Na het opslaan van de lichtstand blijft de Editor in tact en men kan doorgaan met het 
programmeren van de volgende lichtstand dat gebaseerd is op de vorige lichtstand. 
 
Het verschil tussen Action en Enter syntaxis is in grote lijnen dat in Action syntaxis 
men kiest voor een bepaalde handeling en deze wordt direct uitgevoerd. 
In Enter mode wacht de console op een bevestiging d.m.v. de Enter toets. 
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De basis beeldschermindelingen (lay-out) 
 

Na het opstarten, openen de touch screens met de basis beeldschermindelingen 
(Default Lay-out). De indelingen zijn volledig aan te passen aan de 
persoonlijke behoeftes en gewoontes. Het is verstandig eerst bekend te worden 
met de basis beeldschermindelingen voordat er van alles veranderd wordt. 

 
 
 

 
 

Figuur 1: Hoofdscherm – basis indeling 
 

 Menu bar – De menu werkbalk verschijnt op alle schermen. 

 Soft Keys – Soft keys geven toegang tot de meeste programmeer- en 
playback onderdelen. Gebruik de ‘splitter’ om de soft keys tabblads 
op elkaar te stapelen. Soft Keys worden in de Workspace ingedeeld. 

 Master playback – Toont de huidige en komende cue en nog andere 
playback informatie. 

 Cue sheet – Toont de cuesheet van één van de QLists. 

 Editing Toolbar – De systeem werkbalk is contextgevoelig: de 
werkbalk veranderd afhankelijk van de gebruikte functie. 

 Wheel Assignments – Het scherm dat de wieltoewijzingen toont is 
contextgevoelig: het scherm veranderd afhankelijk van de keuze van 
de schijnwerper. Wielen kunnen ook gebruikt worden om effecten te 
programmeren. 
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Figuur 2: Scherm 2 – basis indeling 

 
 Spot display – Het Live scherm voor spots kan aangepast worden in  

het VIEW menu (View Properties). 
 Playback Wing 1 -Het playback scherm toont de geladen QList, de 

huidige cue, de volgende cue en aanvullende informatie voor iedere 
fader. De getoonde informatie kan gewijzigd worden in het VIEW 
menu. (View Properties). 

 
 

BELANGRIJK! Het is verstandig de beeldschermindelingen vast te zetten om 

onbedoeld verschuiven te voorkomen. Druk  op de Windows werkbalk of 
in het Windows menu. 
 
 

Navigeren en aanwijzen 
 

De gebruikersinterface van Vector zal bekend voorkomen bij alle 
computergebruikers (en dat is zo’n beetje iedereen). 
 
Menu’s, werkbalken, bestandsstructuren, en invulschermen maken het 
gemakkelijk je weg te vinden. 
 
Het aanwijsapparaat is een muis aangesloten op het achterpaneel of de 
trackball in de muisfunctie. 
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De trackball gebruiken 
 

De trackball met dubbele functie kan gebruikt worden om pan/tilt waarden in 
te voeren of als muis. In het laatste geval functioneren de toetsen links 
onderaan bij de trackball als linker- en rechter muisknop. 
 
De trackball als muis gebruiken 
 

Druk MOUSE. De MOUSE LED knippert. De trackball is nu een 
besturingsapparaat geworden. 

 
NB: Druk nogmaals op MOUSE en de trackball kan weer gebruikt worden        
voor pan en tilt. 

 
Navigeren en scrollen met de beeldschermen 
 

Het verticale wiel kan gebruikt worden als het scrollwiel bij 
spreadsheets/rekenbladen. 

 
Indien het verticale wiel is geactiveerd voor Windows, dan is het mogelijk om 
met behulp van de toetsen van het bedieningspaneel cijfers in te voeren en te 
navigeren tussen de velden van de verschillende schermen. Het groepje toetsen 
boven de trackball functioneert als de pijltjestoetsen. 

 
Het verticale wiel instellen voor scrollen 

 
Druk SCROLL WIN. De SCROLL WIN LED knippert. Het bericht Windows 
Mode Active!!! verschijnt over de opdrachtregel. 
 

 
BELANGRIJK! Zo gauw SCROLL WIN actief is, is het numerieke 
toetsenbord niet te gebruiken om schijnwerpers te bewerken en is het wiel niet 
voor intensiteit te gebruiken. 
 
 
Aan het einde van de menubalk bevinden zich enkele navigatieknoppen.  

 
 

 
Figuur 1: Navigatieknoppen 

 

- Eén scherm terug 
- Eén scherm vooruit 
- Eén niveau omhoog 
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De kleuren Codes op het scherm 
 

Het standaard kleurenschema is: 

 Geel – Namen en nummers van schijnwerpers die actief zijn in de 
Editor. 

 Rood – (vakje rondom de waarde)Waardes die direct door een wiel 

gecontroleerd worden. 

 Wit (vakje rondom de waarde)– Waardes in de Editor, maar die niet 
direct door een wiel gecontroleerd worden. 

 Blauw – Waardes in de Master Playback die hoger zijn t.o.v. de 
vorige cue. 

 Groen - Waardes in de Master Playback die lager zijn t.o.v. de 
vorige cue. 

 Rood- Redundant, onveranderde waarde. 
 Paars- tracking waarde. 
 Geel - Output van al andere faders.(dus niet de Master) 

 
NB: Waardes in wit en rood worden normaal gesproken opgeslagen in een 
cue. Meer mogelijkheden om op te slaan, vind je in het Store Options scherm; 
 (TOOL>SETTINGS>BEHAVIOR). 

 
 
 
 

De beeldschermen instellen  
 

Ieder scherm bevat: 

 Een algemeen scherm (die kan meerdere workspaces bevatten) 

 Het  menu werkbalk 

 De opdrachtregel en de statusregel. De statusregel (Indication line) 
toont de actuele situatie, de huidige en de volgende cue in de Master 
playback, het niveau van de General Master ( Grand Master) en de 
klok. 

 Optioneel – de hoofdwerkbalk met de titel van de show en iconen 
om je scherm te minimaliseren, vergroten, verkleinen en te sluiten. 
Deze werkbalk is niet standaard aanwezig. (Window menu> 
Show/Hide Window Title). 
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Nieuwe weergave openen 
 

Het splitter mechanisme biedt de mogelijkheid je scherm te splitsen en nieuwe 
weergave’s te maken. 

 
Er zijn drie manieren je scherm te delen: 

 
Figuur 1: Display Setup werkbalk 

 
 Split horizontally – Splits het actieve scherm horizontaal. 

 Split vertically – Splits het actieve scherm verticaal. 

 Add a tab to an existing pane - Open een nieuwe tabblad in de 
actieve weergave. De inhoud van de tabblad wordt gedefinieerd in 
de Workspace 

  
Het is ook mogelijk om het  rechter muis knop menu te gebruiken om het scherm in te 
delen: 

 
Figuur 2: Display short cut menu 
 
Ieder beeldscherm bevat meerdere Work Spaces (werkbladen),deze kunnen opnieuw 
ingedeeld worden naar eigen wens. Om een nieuw werkblad te maken, kies uit het 
menu de optie Add Workspace. 
 

 
Figuur 3: Workspace tabs 
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Iedere gebruiker kan zijn eigen lay-out opslaan. Dat doet men in het menu 
Windows>Layout. 
 

De werkbalk beeldschermindeling 
            De mogelijkheden voor beeldschermindeling staan in het Window menu. 

 
Nieuwe schermen openen 
 

Nieuwe schermen worden altijd in klein formaat geopend in het hoofdscherm. 
Deze zijn verplaatsbaar naar een leeg beeldscherm. Het is niet altijd nodig 
nieuwe schermen te gebruiken. 

 
Een scherm openen en verplaatsen: 

 
1 Ga naar het Window menu >Window Options> New Window. Een 

nieuw scherm verschijnt in het hoofdscherm. 
2 Met de muis kan het scherm verplaats worden naar één van de 

andere externe beeldschermen. 
3 Daar kan men het scherm maximaliseren. 

  
 
 

De Workspace gebruiken 
 

De Workspace bevat een ‘tree’(boomstructuur). Klik op een onderdeel uit de 
Workspace en dat onderdeel verschijnt in het actieve scherm. 

 
Klik op het plusteken (+) om de ‘tree’ uit te vouwen. Klik op het minteken (-) 
om de ‘tree’ in te klappen. 
 

 
Figuur 4: De Workspace (‘Tree’) 
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De Workspace openen en verbergen 

 

Klik  in de menu werkbalk. De Workspace verschijnt in een 
verplaatsbaar scherm. Dit schermpje kan geplaatst worden rechts op het 
beeldscherm. klik weer om te verbergen. 

 
De Compulite verkenner 
 

De Compulite Browser/verkenner toont in het actieve scherm de algemene 
showinformatie: 
 
 

 
Figuur 5: De verkenner toont showinformatie 

 
Klik in de Workspace Tree om de onderdelen te weergeven: 
 

• Sets      • QLists 
• Libraries/Bibliotheken   • Groups/Groepen 
• Snaps     • Macro’s 

 
De Compulite verkenner gebruiken om showelementen te bekijken 

 
Voorbeeld: Bekijk Qlist1 cue 1. 

 
1 Klik QLISTS. Op je scherm verschijnt: 

 

 
 

2 Klik + om de QLists uit te vouwen. 
3 Klik QLIST 1. Op je scherm verschijnt: 
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4 Klik + om de QList 1 uit te vouwen. 
5 Klik CUE 1. Alle kringen en spots zijn te zien met bijbehorende 

parameterwaardes. 
 
 
 

Soft Keys instellen 
 

Iedere scherm kan vele tabsblad bevatten. Een aan een scherm toegevoegde 
tabblad functioneert of als spreadsheet of als soft keys.  

 
Om de tabblad te tonen als genummerde knoppen(softkeys) of wel als 
spreadsheet, actiever de tab door er op te  klikken.  

Klik  dan  op de menu werkbalk in het Window menu. 
 
 

Een nieuwe tabblad te openen 
 

Ga naar het Window menu en klik . Een nieuwe tabblad verschijnt 
in het actieve venster. 

 
Soft keys definiëren 
 

Tabs kunnen gedefinieerd worden als soft keys voor bibliotheken (Library), 
QLists, groepen, snaps, of macros enz. 

 
Een tab definiëren 

 
Maak een tab voor positiebibliotheken. 

 
1 Klik op de tabblad om die te activeren. 

 
2 Open de Workspace. 

 
3 Vergroot het Library/Bibliotheek onderdeel . 

 
4 Klik POSITION. 
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5 Ga naar de volgende tabblad en herhaal vanaf stap 3 tot alle soft 
keys gedefinieerd zijn. 

 
 

 
 
Wisselen van pagina’s met soft keys 
 

Het aantal getoonde soft keys hangt af van de grootte van het scherm. 
 

Een andere pagina met soft keys kiezen 
 

Druk SCROLL/WIN en gebruik NEXT and PREVIOUS. 
Of 

 
Gebruik PageUp en PageDown op het toetsenbord. 

 
Of 

Gebruik de pijltjestoetsen op de hoofdwerkbalk. Klik  om de 
hoofdwerkbalk te tonen/verbergen 

 
 
 
 

Menu’s en werkbalken 
 

De menu’s van Vector verschijnen in de menuwerkbalk boven in het scherm. 
In elk menu zijn de werkbalkfuncties beschikbaar danwel een werkbalk te 
openen. Werkbalken kun je plaatsen onder de menuwerkbalk 
 

Menu Functies en werkbalken 

 
File/Bestand • Bewaar en open showbestanden 

• Print shows 

 
View/Beeld 

• De weergave’s op je scherm aanpassen. Dit bepaalt 
hoeveel kringen en parameters zichtbaar zijn. 

• instellenvan de  live views te verspringen naar (Jump 
to) fixture selectie (spots and channels) of  naar een 
parameter selectie (spots). 

• Open het Grid Properties scherm. 
• Toon/verberg de View werkbalk 
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Tools/ 
Eigenschappen 

• Open de Patch Manager. 
• Open het System Settings scherm. 
• Open het Settings scherm. 
• Toont de real-time status. 
• Het standaard scherm aanpassen. 

 
 
 

Menu Functies en werkbalken 

 
Format/ 
Opmaak 

• Bepaal de opmaak van de parameterwaardes (percentage, 
decimaal, of hexadecimaal) in de live schermen voor 
kringen en spots. 

• Toon details over tijd, bibliotheek, effect en profile in de 
parametercellen. 

• Toon/verberg de Format werkbalk 
 
LiveMode • Bepaal welke schijnwerpers zichtbaar zijn in de Live 

schermen van kringen en spots. Bv: alle schijnwerpers, of 
alleen actief op het podium of alleen in de Editor, enz. 

• Toon/verberg de LiveMode werkbalk 

 
Topo/ 
 
 

• Middelen om een actieve plattegrond te maken. 
(topografische kaart van de posities van de schijnwerpers) 

• Toon/verberg de Topo werkbalk 

 
Window • De weergave’s indelen in het algemene scherm. 

• Schermen vastzetten. 
• Toon/verberg de Display Setup werkbalk. 
• Bewaar en laad schermindelingen. 
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Hoofdstuk 2: Een nieuwe Show 
beginnen en Patchen 

 
In dit hoofdstuk wordt de Patch Manager behandeld en leer je: 

 Een nieuw Show bestand/File te openen 

 Devices inladen 

 Schijnwerpers/Fixtures aanmaken en patchen 

 Schijnwerpers/Fixtures en adressen verwijderen 

 De Patch aan de Show toewijzen 

 Schijnwerpers/Fixtures een adres toekennen dmv de DIM toets 

 

 

Een nieuwe Show File openen 
Bij het openen van een nieuwe Show File, begint de Vector met een schone lei. 
Alle Show data inclusief Patch, instellingen en standen worden opgeschoond. 
 

Een nieuwe show beginnen 
1 Ga naar het Bestand/File menu. 

 
2 Kies New Show /Nieuwe Show. u wordt gevraagd de huidige show 

op te slaan. 
 
3 Klik YES of NO. Alle gegevens van de huidige show inclusief de 

patch worden van de Vector verwijderd. 
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De Patch Manager 
 

Bij een nieuwe show is de Patch leeg en zal de Vector ingesteld moeten 
worden voor het aantal schijnwerpers dat gebruikt gaat worden in de 
voorstelling. Het openen van een nieuwe show file maakt de Patch leeg en 
verwijdert alle data van de vorige show. 
 
De Patch Manager omvat alle Patch en configuratie werkzaamheden: 
 
 De verschillende soorten schijnwerpers van de voorstelling bepalen. 

 Het aantal schijnwerpers bepalen. 

 Een nummer aan de schijnwerper toewijzen, zoals je die bij het 
programmeren wilt gebruiken. 
 De pan en tilt instelling voor bewegend licht schijnwerpers aanpassen. 

 Schijnwerpers een DMX adres geven. 
 

De Patch is opgezet volgens het Spreadsheet model. Iedere (licht-)set heeft zijn 
eigen werkblad. In de versie 1.0 zijn alleen Kanalen/Channels en Bewegend 
Licht/Spots geïmplementeerd. 
 
Tijdens het Patchen berekent Vector automatisch de lengte van het DMX adres 
voor de gebruikte schijnwerpers. 
 
Zelfs indien de Patch Manager geopend is, blijven alle voorstellingsfuncties 
bereikbaar. 
 
De Patch Manager openen 

 
1 Ga naar het Tools menu. 
 
2 Selecteer Patch Manager; de Patch Manager wordt geopend en toont 

de Patch Workspace, de actieve Patch, en de Patch knoppenbalk. 
 

Devices importeren 
 

Devices worden geïmporteerd uit een lijst van Device bestanden/Files. 
 
Een Device importeren 

1 Klik op ; dit opent een lijst met Device bestanden/Files. 
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2 Dubbelklik op het gewenste Device; het instrument wordt toegevoegd 
aan de Device map van de Patch Manager. Het Device is nu terug te 
vinden in de map Device in de Patch Workspace 

 
En om meerdere Devices te importeren 
Toets Ctrl + klik op de verschillende Devices. Klik OK. 

 
3 U  kunt ook stap 2 herhalen en meerdere Devices inladen. 
 

Schijnwerpers/Fixtures aanmaken en patchen 
 

Om schijnwerpers/Fixtures te kunnen patchen moet je ze eerst aanmaken. 
 
Er zijn twee aparte schermen: één voor het aanmaken van schijnwerpers en één 
voor het patchen van schijnwerpers. Er is ook een gecombineerd scherm waar 
u een schijnwerpers kunt aanmaken én adresseren.  

 
 
 
 
 
 
 
 
 
 

Een schijnwerper/Fixture aanmaken en patchen 
 
1 Kies Channel of Spot onder de Sets node in de Patch Workspace. 

2 Klik ; het Create and Patch scherm verschijnt. 
 
3 Klik Import Device om een Device te selecteren uit de Device-lijst. 
 
4 Type het gewenste aantal schijnwerpers in het Number of Fixtures 

to Create veld. 
 
5 Geef een startnummer in het Start Number veld. Het startnummer 

refereert aan het schijnwerpernummer. Voorbeeld: Om 24 Mac 500 
schijnwerpers aan te maken met de nummers 1 t/m 24, vul in 1.  

 
6 Optie: Verander de standaard naam van de schijnwerper/Fixtures in 

het Name veld. In het Live scherm verschijnt de nieuwe naam. 
 
7 Optie voor bewegend licht: Wijzig de pan en tilt instelling. 
 
8 Klik NEXT. Het Patch adresseergedeelte verschijnt. 

   
 

   
   

   
 

Schijnwerpers aanmaken. Patchen van schijnwerpers 
aan schijnwerpernummers. 
 
Schijnwerpers een DMX-adres geven. 
 
Schijnwerpers aanmaken en patchen. Patchen van 
schijnwerpers aan nummers en DMX-adressen. 
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9 Geef het Connector Poort Nummer in het Port veld 
 

10  Vul de DMX startadres in het Address veld 
11 Vul het gewenste interval in het Interval veld. De standaard interval is 

de lengte van het DMX-adres 
 

12 Klik FINISH; het scherm verdwijnt. Nu ziet u de Patch spreadsheet 
voor de aangemaakte (licht-)set. 

 
NB. Als u niks invult bij stap 10 en 11 kan de Vector ook de Auto Setup 

gebruiken, door het eerst vrije DMX-adres toe te wijzen.  
 

Schijnwerpers/Fixtures en adressen verwijderen 
 
Schijnwerpers/Fixtures en Patch adressen kunnen op ieder gewenst moment 
worden verwijderd. 
 
Een schijnwerper verwijderen 

 
1 Kies de juiste Set (Channel of Spot). 

2 Klik . Het Delete Fixtures scherm verschijnt. 
 

3 Geef de schijnwerpernummers in de From No. en To No. velden. 
 

4 Klik OK om op te slaan en sluit het scherm. De gekozen 
schijnwerpers/Fixtures zijn verwijderd van de Patch en komen niet 
meer voor in de spreadsheet 
 
Of 
Klik APPLY en hou het scherm open. 

 
Een adres verwijderen 

 
1 Kies de juiste Set. 

2 Klik . Het Clear Patch scherm verschijnt. 
 

3 Geef de schijnwerpernummers in de From No. en To No. velden. 
 

4 Klil OK om op te slaan en sluit het scherm. De Patch voor de gekozen 
schijnwerpers/Fixtures is leeggemaakt en komt niet meer voor in de 
spreadsheet. 
 
Of 
Klik APPLY en hou het scherm open. 
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De Patch bewaren en de Patch Manager sluiten 
 

Sla de Patch op (Apply) als u de gewijzigde gegevens wilt bewaren, update de 
show en werk verder in de Patch Manager. Bij het werken in de Patch Manager 
zonder eerst de wijzigingen in de Patch op te slaan kunnen er 
onregelmatigheden optreden. Voorbeeld: je hebt een aantal schijnwerpers uit 
de Patch verwijderd en probeert de vrijgekomen DMX-adressen te gebruiken. 
Je krijgt de foutmelding “Patch Exists” . Dit kan voorkomen worden door eerst 
de gewijzigde gegevens in de Patch op te slaan.  
 
De Patch opslaan 
 

Klik  
 
De Patch Manager sluiten 

1 Klik     u wordt gevraagd de Patch data op te slaan. 
 
2 Klik YES om op te slaan. Klik NO om de Patch Manager te sluiten 

zonder op te slaan.. 
 

NB: Kiest u voor YES, dan wordt bij het sluiten van de Patch Manager 
de Patch automatisch opgeslagen. 

 
 

 

Patchen met M.B.V het bedieningspaneel  
 

Ook met de DIM knop op het toetsenbord van de Vector kan worden 
gepatched. 
 
Gebruik de Workspace om het Output-werkblad te openen, om overzichtelijk 
Live te kunnen Patchen .(Om de Workspace te gebruiken zie pag. 14) 
 
Een Channel of Spot Patchen 
 

Voorbeeld: Koppel Channel 5 aan DMX poort 2 dimmer 24. 
 

1 Kies Channel 5. 
 
2 Klik DIM. 

 
3 Kies 2 (de poort) / (schuine streep) 24 (dimmer) of toets rechtstreeks 

het dimmernummer, in dit geval 536 (512 - Poort 1 + 24 - Poort 2) 
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4 Druk STORE. De statusregel toont Assigned als het Patchen is 
geslaagd. 

 
 

Een adres verwijderen 
 

Voorbeeld: Verwijder het adres van Channel 5. 
 

1 Kies Channel 5. 
 

2 Klik DIM. 
 

3 Druk DELETE. Het Delete scherm verschijnt 
 

4 Druk opnieuw op DELETE. 
Of 

5 Klik DELETE in het scherm. De statusregel toont Released als het 
verwijderen van het adres is gelukt. 
 

 
Meer functies van de DIM Editor Toolbar zijn: 
 

 Clear Patch- de Patch ongedaan maken. 
 External Parameter- het patchen van b.v een externaal dimmer of een 

scroller.  
 Flash dimmer, om een dimmer te kunnen lokaliseren. 
 Park - een parameter op een bepaalde waarde te fixeren zodat de 

RESET functie geen invloed kan uitoefenen. 
 Proportion level- om de dimmer level op een gewenst percentage te 

begrenzen. 
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Hoofdstuk 3: Schijnwerpers kiezen 
en bedienen 

 
 
In dit hoofdstuk wordt beschreven hoe u: 

 schijnwerpers selectereert  

 de Editor reset/ vrijgeeft 

 de statusregel leegmaakt 

 een parameter instelt met behulp van de wielen 

 een parameter instelt met behulp van de cijfertoetsen 

 groepen opslaat 

 bibliotheken opslaat 

 

 
In vogelvlucht: Schijnwerpers kiezen en 
parameters instellen 
 

U kunt op verschillende manieren schijnwerpers selecteren en die selecties 
filteren. Een parameter instellen kan met behulp van de wielen, de cijfertoetsen 
of een combinatie van parametertoetsen en cijfertoetsen. 
 
Een schijnwerper kiezen en een parameter instellen 
 

Voorbeeld: Selecteer Spot 1  12 en zet een parameter op een bepaald 
niveau. 

 
1 Toets SPOT. 

 
2 Toets 1  12 mbv de cijfertoetsen. 

 
3 Kies de bank. Gebruik de wielen om voor een bepaalde  parameters de 

waarde in te stellen. 
 

4 Gebruik de ‘parameters lagen toetsen’ om te wisselen tussen de 
parameters. 

 
5 Bewaar de lichtbeeld als een Cue. (Voor opslaan  QLists en cues zie 

pag 30) 
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Scherm met gebruikte schijnwerpers 
Live Fixtures Display 
 

Het scherm met de in gebruik zijnde schijnwerpers is in spreadsheet vorm. De 
huidige selectie van schijnwerpers met hun waardes worden hier getoond. 

 
Het scherm met de in gebruik zijnde Schijnwerpers tonen 

 
Ga naar Workspace. Kies Channel of Spot in de Live map. 

 

 
 

Scherm met de in gebruik zijnde schijnwerpers 
 
Tip! Met de functies in het LiveMode menu kun je de inhoud van het 
scherm aanpassen. 

 
 
 
 
 
Schijnwerpers selecteren 

 
Schijnwerpers selecteren kan met behulp van het toetsenbord en de 
‘editing’werkbalk./ Editor Toolbar. 
 
De toetsen die gebruikt kunnen worden voor een schijnwerpersselectie zijn: 
  
Toets Wat doet ie 

SPOT De Editor activeert de Spot modus. 

CHANNEL De Editor activeert de Channel modus. 

0 - 9 Het nummer van de schijnwerper. 

 ‘Tot en met’ voor meerdere Schijnwerpers. Voorbeeld: SPOT, 
1, , 24; Alle 24 Spots zijn geselecteerd. 
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De Editor Toolbar/ ‘Editing’ werkbalk 
 

De Editor Toolbar /‘Editing’ werkbalk bevat een aantal selectie filters. De toets 
EVERY toont de verschillende filter opties. Het voorbeeld hieronder is bv zeer 
geschikt bij de horizonbatterij van een tv studio. (Voor meer informatie zie de 
Reference Guide) 

 
Een selectie filteren 

 
Voorbeeld: Iedere 4de schijnwerper tussen de 1 en 50 beginnend bij de 
tweede schijnwerper. 

 
1 Kies Channels 1 tot en met 50. 

 
2 Kies EVERY. De keuzemogelijkheden worden in de werkbalk 

aangegeven. 
 

3 Kies 4TH of druk 4 op het toetsenbord. 
 

4 Kies / (schuine streep) of druk / (schuine streep) op het toetsenbord. 
 

5 Druk 2 op het toetsenbord. De kringen 2, 6, 10, 14, 18, enz....zijn 
geselecteerd 

 
6 Gebruik de wielen om de kringen een bepaalde waarde mee te geven. 

 
NB. Alhoewel de werkbalk ophoudt bij de 4de, kan ook de 5de, de 6de 
enz. gekozen worden door gebruik te maken van het toetsenbord. 

Toets Wat doet ie 

+ (plus) 
 

Een Schijnwerpers toevoegen aan een selectie. Voorbeeld: 
CHANNEL 1 + 3 + 7 + 11, selecteert de kringen 
1, 3, 7, en 11. 
 

— (min) 
Een schijnwerper uitsluiten van een bepaalde selectie. 
Voorbeeld: SPOT 1  5 — 4, selecteert de Spots 1, 2, 3, 5. 
 

 (punt) 
 

Herhalen van de laatst gekozen schijnwerpers. 
Voorbeeld: De laatst gekozen selectie Spots was 1, 3, 6, and 
8. Druk SPOT  om deze opnieuw te selecteren.  
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Een Spot activeren 
 

Het Spot Control scherm geeft toegang tot alle controle mogelijkheden. De 
mogelijkheden zijn afhankelijk van de eigenschappen van de verschillende 
Spots. 

 
De lamp aanzetten 

 
1 Selecteer de Spots. 

 
2 klik  CONTROL op de Editor Toolbar (werkbalk). Het Spot Control 

scherm verschijnt. 
 

3 Klik LAMP ON en CLOSE. 

NB. Indien CONTROL niet verschijnt op de Toolbar, druk  om  
verborgen knoppen te tonen. 

 
 
 
 
 
De statusregel leegmaken 
 

De statusregel kan in de ruststand gezet worden of leeggemaakt, te beginnen 
met het laatst ingevoerde gegeven. 

 
Weghalen van gegevens (backspace) 
 

De statusregel leegmaken in omgekeerde volgorde. 
 

Druk CE. De laatste invoer verdwijnt. Blijf op CE drukken. Iedere keer 
verdwijnt de laatste invoer in de statusregel. 

 
De statusregel in de ruststand plaatsen 
 

Druk SHIFT + CLEAR. Alle invoer in de statusregel verdwijnt in de 
statusregel is terug in de ruststand. 
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De Editor leegmaken (Resetten) 
 

De Editor leegmaken: 
 

Druk RESET. Alle waardes in de Editor worden in een fade 
(standaard/Default) van  1sec vrijgegeven  
Druk  RESET snel 2 keer: alle waardes worden in 0 sec vrijgegeven. 

 
 
 
Parameters instellen 
 

De wielen en Trackball worden gebruikt om Spot parameters en  Channel 
niveau’s in te stellen. Absolute waardes kunnen ingevoerd worden met behulp 
van de cijfertoetsen.. 

 
De wielen en wielbanken gebruiken 
 

De vijf horizontale wielen zijn voor alle parameterinstellingen, incl. dimmer en 
pan/tilt. Het verticale wiel is voor de dimmerfunctie van alle schijnwerpers. 
Met de Trackball verander je de pan en tilt van de Spots. Het verticale wiel en 
de Trackball komen niet voor in het wiel-toewijzing-scherm.  

 
De schijnwerper parameters zijn verzameld in de wielbanken. Indien een wiel 
meer dan 1 laag aan parameters bevat kun je met de blanco toetsen boven het 
wiel een parameter dan wel een nieuwe laag kiezen. Iedere wiel heeft 2 blanco 
toetsen: de rechter toets selecteert de parameter, de linker toets bladert door de 
verschillende lagen. 

 
De wielbanken veranderen 

 
Druk op een van de verschillende parametertoetsen: 
INTENS,      POSITION,  COLOR,  BEAM,    IMAGE,     of   SHAPE. 
Intensiteit,   positie,         kleur        bundel,    afbeelding,       vorm 

 
 
Intensiteiten instellen 

 
1. Selecteer de schijnwerpers. 

 
2. Beweeg het verticale wiel of het horizontale ‘dimmer’ wiel, indien de 

INTENS-wielbank is geactiveerd.
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Posities instellen 
 

1 Selecteer de schijnwerpers. 
 

2 Beweeg de Trackball. 
 

Of 
Beweeg de horizontale wielen voor pan en tilt indien de POSITION-
wielbank is geactiveerd. 

 
NB. Met de toetsen naast de Trackball kunnen pan en/of  tilt geblokkeerd worden. 
 
 

Color, image, beam, en shape instellen 
 

Parameters zijn van tevoren ingesteld als continue parameter of als stappen 
parameter. De wielen houden constant controle over beide soorten 
parameters. Speciale knoppen op de werkbalk zorgen voor absolute 
veranderingen tussen 2 stappen. 

 
Voorbeeld: Color en Image instellen. 

 
1 Selecteer de schijnwerpers. 

 
2 Druk COLOR om naar de kleuren wielbank te gaan en gebruik de 

desbetreffende wielen om een kleur in te stellen. 
 

3 Druk IMAGE om naar de afbeeldingen wielbank te gaan. 
 

4 Gebruik het desbetreffende wiel om  een waarde aan te geven. 
 

Parameterstappen veranderen 
 

Voor absolute veranderingen van stap naar stap: 
 

Gebruik STEP UP of STEP DOWN op de Editor Toolbar/ werkbalk. 
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Instellen met behulp van de Pickers 
 

Voor de bekende stappenparameters heeft Vector een aantal Pickers 
voorbereid. Pickers laten plaatjes zien die min of meer overeenkomen met de 
stappenparameters. Er zijn aparte Pickers voor CMY (Cyaan, Magenta, 
Yellow) en RGB (Red, Green, Blue). 
 

 
 
Figuur 1: Gobo picker 

 
Het gebruik van de Pickers 

 
Voorbeeld: Een gobo kiezen 

 
1 Selecteer de Spots. 

 
2 Druk IMAGE om de gobo bank te activeren 

 
3 Dubbelklik op  GOBO WHEEL in de wieltoewijzingen. De gobo 

picker verschijnt. 
 

4 Kies een gobo door er op te klikken ; deze wordt direct gebruikt in de 
schijnwerper. 

 
5 Klik CLOSE om het Gobo Picker scherm te sluiten. 
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Absolute  waardes invoeren 
 

Absolute waardes voer je in met behulp van de cijfertoetsen..  
 
Absolute waardes variëren van  0 - FL. Een absolute waarde voor een 
parameter met vaste stappen houdt geen rekening met de stappen.  
Voorbeeld: een parameter heeft stap 1 (0 – 50%) de dimmer en stap 2 (51% - 
FL) de strobe; een absoluut ingevoerde waarde  b.v. 65% valt in stap 2 de 
strobe. 
 
NB: Om de dimmer in bovenstaand voorbeeld op een absolute waarde te 
zetten, druk je eerst @ voor je met de cijfertoetsen een waarde invoert. 
 
Instellen met behulp van de cijfertoetsen. 
 

Voorbeeld: Zet de dimmer op 60%, pan op 40, tilt op 35, en cyan op 20. 
 

1 Selecteer de Spots. 
 

2 Druk @, 60; de dimmer staat nu op  60%. 
 

3 Druk POSITION, PAN, 40. 
 

4 Druk TILT, 35. 
 

5 Druk COLOR, CYAN, 20. 
 

NB: Er zijn speciale toetsen voor FULL (100%), ON (50%), ZERO (0%). 
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Groepen opslaan 
 

Een groep is een snelkoppeling voor een bepaalde selectie schijnwerpers. 
Groepen worden vaak gemaakt voor schijnwerpers van hetzelfde type, of met 
dezelfde functie.  

Vector maakt automatisch een aantal Groepen aan nadat de schijnwerpers gepatched 
zijn en de Patch Manager gesloten wordt. Dit zijn o.a.: 

 
 Scrollers - Alle scrollers, even en oneven nummers voor scrollers 

 Spots - Alle spots, even en oneven nummers voor spots 

 Een groep voor ieder type schijnwerper 

 
Een groep opslaan 
 

Voorbeeld: Groep 9 is alle Spots die gebruikt zijn bij de Zaallicht. 
 
1 Selecteer de schijnwerpers. 

 
2 Druk STORE. 

 
3 Klik op 9 in de Group Soft Keys tab. 
 
Of 
1 Selecteer de schijnwerpers. 

 
2 Druk GROUP en kies 9 met de cijfertoetsen. 

 
3 Druk STORE. 
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Bibliotheken/ Libraries opslaan 
 

Bibliotheken /libraries zijn bouwstenen. Bibliotheken worden opgeslagen in 
een database en kunnen steeds opnieuw gebruikt worden. Standen kunnen snel 
en doeltreffend worden aangepast indien bij het programmeren gebruik wordt 
gemaakt van bibliotheken. 
 
Voorbeeld 1: De positie van de piano is gewijzigd. Het aanpassen van de piano 
positie bibliotheek zorgt voor een ‘update’ van alle standen waarin deze 
bibliotheek is gebruikt. 
  
Voorbeeld 2: Je hebt veel tijd gestoken in het mixen van een speciaal kleurtje: 
Bewaar deze mix in de kleurenbibliotheek om later nog eens te kunnen 
gebruiken. 
 
Een positiebibliotheek opslaan 

 
Sla positie bibliotheek  1 op. 

 
1 Selecteer de schijnwerpers. 

 
2 Druk  STORE 

 
3 Klik 1 in de Position Library Soft Keys tab. 

 
 

Of 
 
1 Selecteer de schijnwerpers, 
2  stel pan en tilt in. 

 
3 Druk POSITION, 1, STORE. 

 
4 Druk STORE. Een bibliotheek icoontje verschijnt in de pan en tilt 

cellen. 
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Hoofdstuk 4: Cue’s programmeren 
en wijzigen 

 

In dit hoofdstuk wordt beschreven hoe u: 

 QLists/cue-lijsten maakt 

 Cue’s/standen opslaat 

 Cue’s verwijdert 

 Tijden aan een cue koppelt 

 Cue’s wijzigt 

 
 
 
 
QLists 

 
Alle cue’s/standen worden verzameld in QLists. 
 
Tenzij anders aangegeven, worden alle cue’s in de standaard/Defualt  QList 
opgeslagen. De standaard Qlist staat actief in de master playback device (dat is 
de playback waar de SELECT key LED brandt, bv A/B crossfader) 
 
QLists kunnen op ieder playback device worden opgeslagen en cue’s kunnen 
op ieder moment worden toegevoegd. Met de SELECT toets kun je QLists en 
cue’s opslaan/ laden op de playback device. 

 
 
 
Cue’s 
 

Cue’s worden altijd opgeslagen in een QList. 
 
De Editor wordt niet leeggemaakt na het opslaan van een cue. De 
schijnwerpers die actief waren in de Editor blijven beschikbaar. 
 
De opgeslagen cue wordt direct geladen in een playback device. 
 
Normaliter worden de rode en witte waardes uit de Editor opgeslagen in een 
cue. 
 
Cue’s kunnen genummerd worden van  0.01 t/m 9999.99. 
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QLists en cue’s opslaan 

 
De SELECT toets gebruik je om QLists te maken en om cue’s op te slaan in de 
QList onder A/B of een fader. Een scene kan in verschillende QLists worden 
opgeslagen. Gebruik SELECT voor iedere QList. 

 
Een nieuwe QList maken 
 

Voorbeeld: Maak QList1 onder de A/B crossfader. 
 

1 Druk QLIST en 1 met de cijfertoetsen. 
 
2 Druk SELECT voor A/B. In de opdrachtregel verschijnt: Playback AB 

Assigned. QList 1 is geladen in AB. 
 
 

Een cue opslaan 
 

Voorbeeld: Sla cue 1 op in QList 1, die zich onder A/B bevindt. 
 

1 Kies enkele schijnwerpers en verander een aantal parameters. 
 
2 Druk STORE. 
 
3 Druk SELECT voor A/B. In de opdrachtregel verschijnt: Playback AB 

Assigned: QList 1 Cue 1 Stored. 
 

Cue’s aan een QList toevoegen 
 

Voorbeeld: QList 1 cue 1 is onder de  A/B faders. Store cue 2. 
 

1 Kies enkele schijnwerpers en verander een aantal parameters. 
 
2 Druk STORE. 
 
3 Druk SELECT voor A/B. In de opdrachtregel verschijnt: Playback AB 

Assigned: QList 1 Cue 2 Stored. Cue 2 is de output van A/B. 
 

Punt cue’s opslaan 
 

Voorbeeld: Sla cue 2.5 op in QList 1, die zich onder A/B bevindt. 
 

1 Kies enkele schijnwerpers en verander een aantal parameters. 
 

2 Druk CUE 
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3 Druk 2  5. 
 

4 Druk STORE. In de opdrachtregel verschijnt: Playback AB Assigned: 
QList 1 Cue 2.5 Stored. Cue 2.5 is de nieuwe output van A/B. 

 
 
 
 
Cue’s verwijderen 
 

Losse cue’s of een reeks van cue’s uit een QList, kunnen worden verwijderd 
uit de show. 

 
Een cue verwijderen 

 
Voorbeeld: Verwijder cue 9 van QList 1. 

 
1 Kies Qlist 1 cue 9. 

 
2 Druk DELETE. Er verschijnt Object Exists/object bestaat. 

 
3 Druk opnieuw DELETE. 

 
Of 

 
Kies DELETE op het scherm. Na een geslaagde verwijdering 
verschijnt Deleted in de opdrachtregel. 

 
 
 
 
Tijden aan een cue koppelen 
 

Standaard wordt aan een cue een tijd van 4.0 sec gekoppeld.  
 
Een tijd van 0 sec verschijnt als cut op het scherm. 
 

Tijdinstellingen  Functie 
 

TIME  Geeft de werkbalk voor tijd-opdrachten. 
 

TIME IN  De tijd voor alle parameters die in waarde toenemen. 
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TIME OUT De tijd voor alle parameters die in waarde afnemen 

 
DELAY IN  Dit is de tijd die alle parameters, die in waarde 

toenemen, wachten met faden. 
 

DELAY OUT De tijd die alle parameters die in waarde afnemen, 
wachten met faden 

 
WAIT Na het indrukken van  WAIT zijn er 2 mogelijkheden: 

FOLLOW ON  en MANUAL.  
Geef je een wait-tijd (WAIT #) aan een cue, dan wordt 
het vanzelf een follow-on cue. Na het indrukken van 
de GO knop, heeft de cue nog een wacht tijd en pas als 
die verloopt, fade de cue in. 

 
FOLLOW ON  OPVOLG-cue, volgt zonder op een ‘Go’ te wachten op 

de voorgaande cue 
 

MANUAL  MET DE HAND-cue. Wacht wel op een ‘Go’. Manual 
is de standaard instelling voor alle cue’s. 

 
 
 

Tijden instellen tijdens het programmeren van een cue 
 

Voorbeeld: Geef de volgende fade tijden aan QList 1 cue 5. 
 

Time in Time out Delay in Delay out Wait 

4.5 Default (4.5) 3,0 2.0 Manual 

 
 

1 Kies QList 1 cue 5. 
 

2 Druk TIME. De werkbalk voor tijd-opdrachten verschijnt. 
 

3 Voor time-in, druk 4.5 met de cijfertoetsen. 
 

4 Druk DELAY IN en 3 met de cijfertoetsen. 
 

5 Druk DELAY OUT en 2 met de cijfertoetsen. 
 

6 Druk STORE. 
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Time-in en time-out instellen 
 

Geef cue 1 een time-in van 5 sec en een time-out van 10 sec. 
 

Druk: CUE, 1, TIME, 5, / (schuine streep), 10, STORE 
 
Delay-in en delay-out instellen 
 

Geef cue 1 een delay-in van 3 sec en een delay-out van 5 sec. 
 

Druk: CUE, 1, TIME, DELAY-IN, 3, / (schuine streep), 5, STORE 
 
Een follow on cue instellen 
 

Voorbeeld: Nadat cue 2 helemaal uitgefade is volgt automatisch cue 3. 
 

Druk: CUE 2, TIME, WAIT, FOLLOW-ON, STORE 
 

NB: De follow on toewijzing staat bij cue 2. 
 
Een WAIT-time instellen 
 

Voorbeeld: Geef cue 5 een wait-time van 3 sec. De fade van cue 5 naar cue 
6 zal automatisch verlopen. 

 
Druk: CUE 5, TIME, WAIT, 3, STORE. Cue 6 wordt vanzelf een follow-
on cue. Nadat cue 5 uitgefade is, wacht cue 6 vervolgens 3 sec en begint 
vervolgens te faden. 

 
 
 
 
Meerdere QLists 
 

Tijdens het programmeren van een voorstelling is het mogelijk meerdere 
QLists in verschillende playback device’s geladen te hebben. Cue’s opslaan 
wordt beschreven in QLists en cue’s opslaan (zie pag. 36). 
 
De QList in de master playback device is de standaard (default) QList. Tenzij 
je iets anders aangeeft worden de cue’s in deze standaard QList opgeslagen. 
The Master Playback (zie pag.  44). 

            
Een nieuwe QList maken en een cue opslaan in de master playback 
 

Sla op: QList 9 cue 2. QList 9 is geladen op fader 1, de master playback. 
 

1 Kies enkele schijnwerpers en verander een aantal parameters. 
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2 Druk CUE en 2. In de opdrachtregel verschijnt: QList 9 Cue 2. 
 

3 Druk STORE. Cue 1 wordt de output van de master playback. 
 
NB: Je hoeft de QList niet aan te duiden indien die Qlist zich in de 
master playback bevindt. 

 
Een cue opslaan in een playback device 

 
Voorbeeld: Sla op: cue 2 in QList 12 op fader 1. 

 
1 Kies enkele schijnwerpers en verander een aantal parameters. 

 
2 Druk QLIST en 12, om QList 12 te selecteren. 

 
3 Druk CUE en 2 . In de opdrachtregel verschijnt: QList 12 Cue 2 

 
4 Druk STORE. 

 
5 Druk SELECT key van fader 1 

 
 
 
Cue’s wijzigen 
 

Met de UPDATE of STORE toetsen kun je cue’s wijzigen. 
 
Een cue wijzigen (de cue is actief - on stage) 

 
1 Kies enkele schijnwerpers en verander een aantal parameters. 

 
2 Druk UPDATE. Het Update venster verschijnt. 

 
3 Druk SELECT voor de playback device waar de cue onder staat. 
Of 
1 Kies de cue, kies de schijnwerpers, (CUE #, CHANNEL/SPOT #) en 

stel de parameters in. 
 

2 Druk STORE. Klik STORE.  De cue is opgeslagen met de nieuwe 
waardes. 

 
 

 
ATTENTIE! Bij gebruik van UPDATE worden standaard de libraries 
ook gewijzigd. Zet “Update All Libs” uit in het Update venster. 
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Hoofdstuk 5: Playback/weergave 
 

In dit hoofdstuk wordt beschreven hoe je: 

 QLists laadt in een Playback Device 

 Playback Devices leegmaakt 

 de Master Playback Device gebruikt 

 tijdelijke cue’s omzet naar cue’s in een QList 

 Playback Devices vrijgeeft 

 
 
 
 
Playback Devices/weergave-onderdelen 
 

De Playback Devices (PBD’s) van Vector zijn: 

 AB crossfader 

 Faders 

 QKeys 

 
Faders 
 

De faders hebben 3 mogelijke functies/ modus: 

 Playback – De faders regelen de intensiteit. 

 Rate – De faders regelen de snelheid. 

 Channel – Elke fader heeft 1 channel/kring . Het aantal pages/pagina’s 
is onbeperkt 

 
Een fader modus heeft effect op alle faders. 
 
Elke fader heeft een programmeerbare flashtoets en 2 programmeerbare 
toetsen. 
 
De standaard functies voor de programmeerbare toetsen zijn: Go, Back, en 
Flash.  
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Standaard voor een fader is het regelen van de intensiteit/dimmer. De functies 
van een faders kunnen gewijzigd worden door gebruik te maken van de faders 
mode toetsen. 
In het Properties dialoog box> PBD tabblad kunnen de functies van de knopen 
en de fader locaal veranderen per PBD. Druk SET UP,druk  SELECT key v/d 
PBD  om de dialoog box te openen. 

 
 
Qkeys/cue-toetsen 
 
 

Qkeys, geplaatst boven de faders, zijn Playback Devices zonder fader. 
Ze kunnen alles wat een fader kan, maar missen het schuifje. 
 
Iedere Qkey heeft een SELECT toets en een programmeerbare toets. 

 
Wisselen van pagina’s 
 

Er zijn 5 fader en Qkey pagina’s beschikbaar voor Vector Red.  
Voor Vector Blue, Green en Orange zijn er 10 fader en Qkey pagina’s 
beschikbaar. 
 
NB. Een  pagina bevat de fader’s  én de Q-keys. 
 
Dit betekent dus 100 faders en 100 Qkeys per snap (opslagen indeling van de 
gehele Playback). 

 
Een andere pagina laden bij faders en Qkeys 
 

 pagina omhoog; het paginanummer verschijnt op het LCD scherm en op het 
scherm van de Playback sectie. 
 
 pagina omlaag; het paginanummer verschijnt op het LCD scherm en op het 
scherm van de Playback sectie.  

 
NB. Druk PB/QKEY in om in de WING display te verwisselen tussen fader’s 
en de Qkeys weergave.  
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Playback Devices laden en vrijgeven 
 
 

Alle Playback Devices hebben een SELECT toets. Met deze toets kun je een 
QList of een Temp/ tijdelijke cue laden. Ook kun je er de Master Playback 
Device mee aangeven. Elke SELECT toets heeft een groene LED. Als de PBD 
functioneert als Master, dan brandt de groene LED. ( 2x de SELECT knop 
drukken.) 
 
NB: Er kan maar 1 PBD als Master functioneren. 

 
Ieder Playback Device heeft een LED boven de SELECT toets. De kleur van 
de LED geeft de inhoud aan. 

 
LED Kleur   Inhoud 

 
Groen -    QList/ Cue 

 
Rood -    Chaser 

 
Oranje -    Temp/Tijdelijke cue .(Tijdelijke Cues zie 
pag. 41),  
                                      (begrenzend )SUB MASTER 

 
Een Qlist laden in een Playback Device 

 
1 Kies een QList: QLIST #. 

 
2 Druk SELECT bij een Playback Device. 

 
3 De Qlist is geladen in de PBD. De LED boven SELECT brandt 

groen. 
 

Een Playback Device leegmaken 
 

Een PBD leegmaken: 
 

Druk FREE, SELECT; de LED boven SELECT is uit. 
 

Alle Playback Devices leegmaken: 
 

Druk SHIFT + FREE 
 

 Druk 2 x op FREE: de toets blijft actief en je kunt meerdere SELECT 
toetsen na elkaar indrukken. 
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De Master Playback 
 
 

A/B is standaard de Master Playback; indien gewenst kan ieder PBD de Master 
zijn. Als een PBD gekozen is als Master, dan brandt de groene LED in de 
SELECT toets. 
 
Er zijn speciale toetsen en een special LCD scherm voor de Master PBD. 
 
De QList op de Master Playback is de standaard Qlist. Meerdere QLists (zie 
pag. 39) 

 
De Master Playback kiezen: 

 
Druk 2 x SELECT; de LED brandt. 

 
Een QList afspelen in de Master Playback 
 

De Master Playback heeft een aantal specifieke controle toetsen en een LCD 
scherm dat de huidige en volgende cue aangeeft 
 
Faden naar de volgende cue 
 

Druk GO. 
 
Faden naar de vorige cue 
 

Druk BACK. 
 
De fade onderbreken 
 

Druk HOLD. 
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Playback Devices vrijgeven 
 

Een Playback Device vrijgeven onderbreekt de lopende weergave (= Release). 
Het verwijdert niet de QList. 

 
Toets  Gevolg 

 

PB RELEASE + 
SELECT 

De PBD wordt vrijgegeven zonder de PBD leeg te 
maken. 

PB RELEASE + 
SHIFT  
 

Alle Playback Devices worden vrijgegeven. 
Voorbeeld: Onderbreek alle lopende PBD’s zonder ze 
te legen. 

SHIFT+PB 
## 
PB RELEASE 

Geeft alle PBD’s in de geselecteerde reeks vrij . 

Druk 2 x op 
PB RELEASE 

De toets blijft actief en je kunt meerdere SELECT 
toetsen na elkaar indrukken. 

  
 
 
 
 
De Playback schermen bekijken 
 

Er zijn 4 Playback schermen: 

 Playback Wing 1(en 2) 

 Qkeys 1(en 2) 

 A/B 

 Master Playback 

 
In een specifiek playback scherm zoals b.v het A/B of Master scherm kan 
gekozen worden tussen een scherm met informatie (EXAM) over de huidige 
en volgende cue of een scherm met een cue overzicht (cue sheet). 
 
Een Playback detail –scherm openen 
 

Zorg dat het actieve venster ook dat venster is waar je waar je het 
Playback scherm wilt openen. Ga naar de Workspace, klik de Playback 
node open en kies de PBD waarvan je de details wilt zien. 
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Figuur 1: Playback detail-scherm 
 
 

Een cue sheet toont de weergave voortgang. Je kunt de cue sheet bekijken van 
de QList in een PBD. In de rode balk staat de actieve cue. 

 

 
Figuur 2: Playback cue sheet scherm 
 
 

De Playback cue sheet bekijken 
 

1 Activeer een scherm. 
 

2 Voeg een tabblad toe aan een scherm. ( Menu WINDOW) 
 

3 Kies een PBD van de subnode Wing/Qkeys uit de Workspace tree. 
Voorbeeld: Playback>Wing 1 > 8, selecteert fader 8. 
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Tijdelijke/ Temp cue’s 
 

Je kan aan een groep van channels of spots (parameters) waarde geven en fade 
tijd aan toe kennen en dat op een  fader op te slaan, zonder ze eerst als cue op 
te slaan in een QList. Zo’n temp cue (tijdelijk)  kan eventueel gebruikt worden 
als hulpmiddel voor het maken van standen. temp cue (Tijdelijk) wordt in de 
snap op geslagen. 

 
Een groep (tijdelijke cue) laden op een fader 

 
Voorbeeld 1: Laad een tijdelijke cue, een groep channels of spots, in 
Playback fader 1. 

 
1 Kies enkele schijnwerpers. 

 
2 Druk SELECT boven fader 1. In de opdrachtregel verschijnt: 

Playback 1: Temporary cue assigned./Tijdelijke cue geladen 
 

Voorbeeld 2: Laad een tijdelijke cue, met verschillende parameterwaardes, 
in Playback fader 2. 

 
1 Kies enkele schijnwerpers ,kies parameters en ken er waarde aan 

toe. 
 

2 Druk SELECT boven fader 2. In de opdrachtregel verschijnt: 
Playback 2: Temporary cue assigned. 

 
Een tijdelijke cue wijzigen in een cue in een nieuwe QList 

 
Voorbeeld: QLists 1- 3 is reeds gemaakt. Wijzig de tijdelijke cue onder 
fader 10 in cue 1 van een nieuwe QList (Qlist 4) en sla de inhoud van de 
Editor op als cue 2 in dezelfde QList.  
Om te beginnen maak je eerst een tijdelijke cue: 

 
1 Kies enkele schijnwerpers en verander een aantal parameters. 

2 Druk SELECT boven fader 10. 

Verander nu het beeld: 

3 Kies enkele schijnwerpers en verander een aantal parameters. 

4 Druk STORE. 

5 Druk SELECT boven fader 10. Het Object Exists menu verschijnt. 

6 Kies Create New QList./Maak een nieuwe Qlist . Het menu 
verdwijnt. In de opdrachtregel staat: QList 4 Cue 2 Assigned. QList 4 
bestaat nu uit 2 cue’s; de tijdelijke cue (groep) is nu cue 1. 
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Hoofdstuk 6: Chasers 
een snelle wisseling van verschillende cue’s 
 
 

In dit hoofdstuk wordt beschreven hoe je: 

 QLists verandert in chasers 

 Chasers programmeert binnen een QLists 

 Chaser snelheden controleert 
 
 
 
 

QLists als chasers programmeren 
 

Een complete QList kan ingesteld worden als chaser. 
 
De chaser instellingen worden opgeslagen in de QList. 
 
Een QList instellen als een chaser 

 
1 Laad de QList in een Playback Device (PBD). 

 
2 Druk SETUP 

 
3 Druk SELECT (daar waar de QList is geladen). Het Playback 

Properties/Eigenschappen menu verschijnt. 
 

4 Kies Chaser uit het QList Mode menu. 
 

5 Klik OK. De LED van de bijbehorende fader brandt rood. 
 
 
 
 

Loop programmeren binnen een QLists 
 
Een aantal opeenvolgende cue’s in een QList kunnen ingesteld worden als een 
chaser. Koppel eerste cue en de laatste van de geplande chaser aan elkaar en 
voer het aantal loops/herhalingen in. 
 
Het maken van de koppeling en het aangeven van het aantal cyclus herhalingen  
gebeurd in dezelfde handeling. 
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Cue’s koppelen en het aantal loops instellen 
 

Voorbeeld: Loop cue 4 aan cue 8 twee keer. 
 

1 Druk CUE 48. 
 

2 Op de Editoe Toolbar/ werkbalk klik LOOP.  
 

3 Uit de LOOP submenu op de Editor Toolbar kies LOOP COUNT en 
voer een getal in. De opdrachtregel vraagt om een cue nummer. 

 
4 Druk STORE. 

 
NB. als u de standaard loop ( Auto Loop) gebruikt  maak je een oneindige 
loop. 
 

 
 
 

Controle uitoefenen op chasers 
 

De controle toetsen voor een chaser zijn: 
 

Toets  Gevolg 
 

GO Start de chaser. 

HOLD Stopt of pauzeert de chaser. 

STEP Manueel van cue naar cue springen. 

 De richting van de chaser omdraaien. 
 
 

De eigenschappen van een chaser kunnen tijdens het afspelen gewijzigd 
worden of voorbereid in het  Properties/Qlist Properties tabblad. 
 
 Chaser Rate – beïnvloedt de snelheid van de chaser. 

 XFade – beïnvloedt het gedrag van de chaser. 0 (Cut) voor een harde 
chaser (springt van cue naar cue). Alle waardes boven 0 zorgen voor 
een soft chaser (faden van cue naar cue). Hoe hoger de waarde hoe 
trager de fade 
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De snelheid van  de chaser tijden het afspelen beïnvloeden 
 

Door op RATE (geplaatst onder het touch screen) te drukken verandert 
de functie van de fader. Gebruik nu de fader om de rate (snelheid) te 
beïnvloeden 

 
Of 

 
1 Druk op de PB RATE toets. 

 
2 Druk SELECT bij de PBD waar de chaser draait. 

 
3 Gebruik het rate wiel om de snelheid in te regelen. 

 
 

De chaser snelheid vooraf instellen 
 

1 Druk SETUP.  
 

2 Druk SELECT bij de fader waar de chaser geladen is. Het Properties 
menu verschijnt, kies de Qlist Properties tabblad. 

 
3 Stel de Chaser Rate en X-Fade in, gebruikmakend van de pijlen of 

de parameterwielen. 
 

4 Druk OK. De snelheid van de chaser is opgeslagen als een 
eigenschap van de QList. 

 
 

Hoofdstuk 8: Voorstellingen openen en bewaren 
 

In dit hoofdstuk wordt beschreven hoe je: 

 Een voorstelling opslaat 

 Een voorstelling(bestand) opent 

 Beeldschermindelingen opslaat en opent 

 
 
 
 

Voorstellingen opslaan 
 

Opgeslagen voorstellingsbestanden bevatten alle voorstellingsgegevens, alle 
patch-informatie en schermindelingen. De standaard locatie voor het 
wegschrijven van voorstellingsbestanden is D:/Program Files/Compulite 
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Vector/Vector Shows. De bestandsextensie voor voorstellingsbestanden is 
*.cvs. 
 
Het is een verstandig je voorstelling regelmatig op te slaan. 

 
Een voorstelling opslaan 

 
1 Ga naar het File menu. 

 
2 Kies Save AS/opslaan als. Het Save menu verschijnt. 

 
3 Zoek, indien nodig, de map met je voorstellingsbestanden op. 

 
4 Type de naam van het voorstellingsbestand in het File Name veld. 

 
5 Druk SAVE. 

 
 

Belangrijk! Het is verstandig om Save As/opslaan als te gebruiken 
in plaats van Save, om verzekerd te zijn van een back-upbestand. 

 
 
 

Voorstellingen openen 
 

Een opgeslagen voorstelling openen 
 

1 Ga naar het File menu. 
 

2 Kies Open. Het Open menu verschijnt. 
 

3 Zoek, indien nodig, de goede map en kies het voorstellingsbestand. 
 

4 Klik OPEN. 
 
 
 
 

Beeldschermindelingen opslaan en bewaren 
 

Beeldschermindelingen (layout) worden opgeslagen als een onderdeel van een 
voorstelling en kunnen alleen geopend worden als de voorstelling geopend is. 
De standaard locatie voor beeldschermindelingen is D:/Program Files/ 
Compulite Vector/WorkDir/ShowLayout. 

 



52 
 

Beeldschermindelingen kunnen ook bewaard worden als aparte systeem- 
bestanden. Systeembestanden kunnen op ieder moment worden geopend. De 
extensie voor systeembestanden met beeldscherminformatie is *.cfg 

 
Een beeldschermindeling opslaan 

 
1 Klik op Window > Layout >. Het Save As menu verschijnt. 

 
2 Typ de naam van het bestand in het File Name veld 

 
3 Klik SAVE. De beeldschermindeling is opgeslagen. 

 
Een beeldschermindeling laden 

 
1 Klik op Window >Layout> Het Load Layout menu verschijnt. 

 
2 Klik OPEN. De geselecteerde indeling wordt geladen. 

 
Een systeembestand met beeldscherminformatie opslaan 

 
Maak een aparte map voor systeembestanden en bewaar de indeling in 
die map. 
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Hoofdstuk 7: Effecten 
programmeren 

 
 

In dit hoofdstuk wordt beschreven hoe je: 

 

• Effecten programmeert 

• Effectbibliotheken opslaat 

 
 
 
 

Effecten 
 

Effecten kunnen gemaakt worden voor elke schijnwerper en elke parameter. 
Een effect kan gemaakt worden voor ieder aantal spots, channels of scrollers.  
 
De volgorde van de schijnwerperselectie bepaalt de volgorde waarin de 
effecten met een ‘offset’ worden uitgevoerd. Voorbeeld: selecteer je spot 1  
12, dan is spot 1 de eerste die reageert, dan spot 2 enz. Is de volgorde van 
selecteren spot 12  1, dan is spot 12 de eerste die reageert, spot 11 de 
volgende enz. Dit geldt ook voor een onregelmatige selectie van spot zoals 
spot 5, spot 7, spot 4, spot 8, enz. De eerste in de rij is de eerste die reageert. 
 
Effecten worden geprogrammeerd en bewerkt in het Effect Editor menu. 

 
Een effect programmeren 

 
1 Kies enkele schijnwerpers en een (aantal) parameter(s). 

 
2 Druk EFFECT. Het Effect Editor menu verschijnt. De indeling van 

de wielen verandert in de Effect wielenbank. 
 

3 Kies een primitive/basis. Het effect wordt meteen uitgevoerd. 
 

4 Gebruik de wielen of de velden in de Effect Editor om het effect aan 
te passen. (Offset, Size, Rate, Duty Circel) 

 
5 Sla het effect op als een cue of als een effectbibliotheek. 

 
 
Nb. In de Effect editor er zijn in de Pre Buit tabblad een aantal voor geprogrammeerde 
effecten. 
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Effecten opslaan 
 

Loopt een effect eenmaal zoals gewenst, bewaar het dan als cue of als 
bibliotheek. 

 
In een effectbibliotheek wordt nooit het type device opgeslagen. Het kan 
gebruikt worden voor alle schijnwerpers en wordt niet begrensd door het aantal 
schijnwerpers dat actief was gedurende het programmeren van de effect-
bibliotheek. 

 
Een effectbibliotheek wordt gebruikt als een patroon. Voorbeeld: tijdens het 
maken van het effect waren er 3 spots in gebruik. Gebruik dit effect voor 9 
spots en het werkt als volgt: 1, 4 en 7 draaien gelijktijdig, 2, 5 en 8 idem enz. 

 
Een effect opslaan in een cue 

 
Dit gaat precies hetzelfde als het opslaan van elk andere cue. Cue’s 
programmeren en wijzigen (zie pag. 36) 

 
Een effectbibliotheek opslaan 

 
1 Bepaal onder welke bibliotheek-soft key het effect moet worden 

opgeslagen. 
 

2 Druk STORE. 
 

3 Druk op een nummer in het effectbibliotheek-soft key veld. 
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Hoofdstuk 8: Voorstellingen openen 
en bewaren 

 
In dit hoofdstuk wordt beschreven hoe je: 

 Een voorstelling opslaat 

 Een voorstelling(bestand) opent 

 Beeldschermindelingen opslaat en opent 

 

 

Voorstellingen openen 
 

Een opgeslagen voorstelling openen 
 

5 Ga naar het File menu. 
 

6 Kies Open. Het Open menu verschijnt. 
 

7 Zoek, indien nodig, de goede map en kies het voorstellingsbestand. 
 

8 Klik OPEN. 
 
 
 
 

Beeldschermindelingen opslaan en bewaren 
 

Beeldschermindelingen (layout) worden opgeslagen als een onderdeel van een 
voorstelling en kunnen alleen geopend worden als de voorstelling geopend is. 
De standaard locatie voor beeldschermindelingen is D:/Program Files/ 
Compulite Vector/WorkDir/ShowLayout. 

 
Beeldschermindelingen kunnen ook bewaard worden als aparte systeem- 
bestanden. Systeembestanden kunnen op ieder moment worden geopend. De 
extensie voor systeembestanden met beeldscherminformatie is *.cfg 

 
Een beeldschermindeling opslaan 

 
4 Klik op Window > Layout >. Het Save As menu verschijnt. 

 
5 Typ de naam van het bestand in het File Name veld 
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6 Klik SAVE. De beeldschermindeling is opgeslagen. 
 

Een beeldschermindeling laden 
 

3 Klik op Window >Layout> Het Load Layout menu verschijnt. 
 

4 Klik OPEN. De geselecteerde indeling wordt geladen. 
 

Een systeembestand met beeldscherminformatie opslaan 
 

Maak een aparte map voor systeembestanden en bewaar de indeling in 
die map. 
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